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1

Introduction

1.1

Welcome to EasyLogger for DS1M12
EasyLogger is the easy to use but powerful data logging application program for the USB
Instruments DS1M12.
It runs on any USB 1.1 or USB 2.0 equipped PC using Windows 98, ME, 2000 or XP.
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1.2

EasyLogger Features
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

Attractive, easy to use visual display
1MHz digital sampling rate
Input saturation ranges from 0.2 V to 20 V
2 logging channels
Signal Generator output
Integrated switch to halt data capture through hardware
User-defined sampling rate
O.S.D. markers for voltage measurement
O.S.D. markers for time measurement
Save screens to Windows BMP files
Export data to CSV and text files
Load saved traces for display and export to other formats
Screen printout facility
Memo functions to comment data
AC/DC coupling support
Support for x1 and x10 probes
User-defined display colour themes
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2

Installing EasyLogger

2.1

Installing the EasyLogger Software
Before connecting the instrument to the PC, insert the supplied installation disk into the CD-ROM
drive of your PC. The following menu will appear after a few seconds.
The EasyLogger program is installed with the EasyScope II program.
Before connecting the instrument to the PC, insert the supplied installation disk into the CD-ROM
drive of your PC. The following menu will appear after a few seconds.

Click on the "Install EasyScope" button to launch the EasyScope installation program. The
following screen will appear:
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Click on the "Next" button to bring up the License Agreement Screen.

If you agree with the terms and conditions of the License Agreement, check the "I agree" box and
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click on the "Next" button to continue the installation process else click on the "Exit" button. The
"Next" button is disabled if you do not agree to the terms and conditions. Agreeing to the terms
and clicking on the "Next" button brings up the following screen.

Select the directory you wish to install the EasyScope software into. A default directory is shown
on the screen. Unless you have good reason to change it we suggest you use the default
suggested by the installation program. Click on the "Next" button to commence copying the files to
the EasyScope program directory.
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A progress screen (shown above) will appear as the files are installed. After a few seconds you
should see the "Installation was completed successfully" message. Click on the "OK" button to
complete the final stage of the installation process.
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The installation process is now complete. You can launch the EasyLogger program from the
desktop by double-clicking on the EasyLogger icon (pictured below).

You can also launch the EasyLogger program from the Start -> Programs -> EasyLogger for
DS1M12 menu on the Windows Toolbar.

As shown above, you also have access to the EasyLogger Help files and Program Uninstaller from
there.
Before using EasyLogger, the USB drivers need to be installed. This is done by plugging the
instrument into a spare USB port on the PC. The instrument should be plugged into a USB hub
port of your PC or alternatively, a self-powered USB hub (one that has it's own power supply).
If this is the first time that the instrument has been plugged in, Windows will then request the USB
drivers for your product. See Installing the USB Drivers for further details.
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Installing the USB Drivers
Before using EasyLogger the USB drivers need to be installed. This is done by plugging the
instrument into a spare USB port on the PC. The instrument should be plugged into a USB hub
port of your PC or alternatively, a self-powered USB hub (one that has it's own power supply).
If this is the first time that the instrument has been plugged in, Windows will request the USB
drivers for your product and will display a Found New Hardware Wizard dialog box. The example
below is for Windows 2000 but the procedure is very similar for other Windows versions.
Connect the instrument to a spare USB port on the PC or self-powered hub. The following screen
will appear to begin guiding you through the driver installation.

Click "Next" to proceed with the installation. The following screen will appear:
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Select the option box for "Search for a suitable driver for my device (recommended)" and click
"Next".
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Check the box for "CD-ROM drives" and un-check all others.
NOTE: If the CD is not available and the EasyLogger software has already been installed, then
check the "Specify a location" box and use the Browse button to select the "drivers" sub-directory
of the EasyLogger Program Files directory instead.
Keep Clicking on "Next" until the installation is finished as per the screen below.

Click "Finish" to complete the installation of the first device.
If using Windows 2000, the second device will be installed automatically. For other versions of
Windows, the above process may need to be repeated to complete the instrument installation.

© 2006 USB-Instruments

13

EasyLogger for DS1M12 Help

3

Using EasyLogger for DS1M12

3.1

EasyLogger Overview
The EasyLogger has a simple layout with easy to use controls. The main controls and features are
highlighted below. A full explanation of each feature is provided in the sections that follow.
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Front Panel Functions

3.2.1

Start Button
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Clicking the Start Data Logger button will commence data capture.

Please note that the controls for altering the sampling rate and vertical scales are disabled while
the data logger is running.
When running, a caption appears at the top right of the data window which says "Running".
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Stop Button
Clicking the Stop button will halt data capture.

The sampling rate and vertical scale controls will be enabled after the stop button has been clicked.
When stopped, a caption appears at the top right of the data window saying "Stopped".
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Sample Interval
Use the Sample Interval control to specify the logging rate before starting to log data.

Any samplig rate may be specified, but invalid sampling rates will be rounded to the nearest
multiple of 1ms when logging starts. Data points may be missed at fast sampling rates on slower
PC systems. Missed data points are indicated with a red cross.
The fastest logging rate possible without missing any samples may be increased by doing one or
all of the following:
·
·
·

Log on only one channel
Disable tracking
Log in raw data format rather than formatted data

© 2006 USB-Instruments

17

3.2.4

EasyLogger for DS1M12 Help

Channel Enable Buttons
The channel enable buttons can be used to enabe or disable a logging channel. When enabled,
the channel enable buttons are coloured.

If the channels are disabled, they are greyed out.

These buttons are disabled while the data logger is acquiring data.
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Slide Bar
The slide bar allows scrolling through the logged data.

The chart display is updated as the scroll bar is moved. If tracking is enabled, the scroll bar is
disabled while running.
The slide bar can be operated by dragging the handle or by clicking the triangular buttons at each
end of the bar.
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Scale Panel
The scale panel indicates the area of the chart currently visible. The default values before logging
are shown below.

These values are updated when data is logged or if scaling values are changed.
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Toolbar Buttons

3.3.1

Open Chart
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Clicking on the Open Chart button will display an open dialog box.

The user can then browse to a file of type .dlog (data logger format) which can then be imported
back into the data logger for viewing. Files of the raw data format (.rdl) may also be loaded. Data
from a .rdl file will be formatted and displayed as normal. If a .dlog file with the same name exists
this can be used to display stored values (i.e. sample rate, maximum, minimum and memos).
Please note that files of type .dlog and .rdl cannot be viewed as text. To export data as text for
analysis in 3rd party applications please export the data as text or comma separated values (.csv).
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Save Chart
Clicking the Save Chart button produces a save dialog box that allows the user to save the current
data chart in a variety of formats.

Either the data chart or load chart (selectable through the Window menu) may be saved.
Bitmap (*.bmp)
Selecting the bitmap option saves the area of the data chart which is currently visible to a bitmap
picture file. This option will not allow access to the actual data for analysis or the data to be
reloaded to the data logger for display.
Comma Separated Values (*.csv)
Selecting to export as .csv exports all of the chart data to a .csv file complete with start and stop
markers which can then be analysed in 3rd party packages. Information on missed or clipped
points is also included. .csv files are automatically associated with Microsoft Excel if it is installed.
Please note that Excel can only handle a maximum of 65536 lines of data. This limits the amount
of logged data that can be viewed from a .csv file. If there are more than 65536 lines to write to the
.csv file, the later lines are not available. It is possible to get around this by editing the .csv in a text
editor (such as notepad), re-saving and then opening in Excel. This file format cannot be reloaded
to the data logger for display.
Text (*.txt)
Exporting as text write all data points and headers to a text file. Unlike .csv files, text files are not
limited to 65536 data points. This will allow access to the logged data for external analysis, but
cannot be loaded into the data logger to display the chart.
Data Log Format (*.dlog)
The data log format cannot be used externally by other programs. It can however be used to
reload previously logged traces to the load chart window. When a .dlog file is loaded, it can be reexported as a bitmap, .csv or .txt file.
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3.3.3

Print Chart Area
Clicking the Print Chart button prints the current chart area of the data logger.

The data printed can be changed by using the slide bar, zoom controls or switching between
data1 and load windows.
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Copy Chart to Clipboard
Clicking the Copy Chart to Clipboard button places a copy of the current chart area on the
Windows clipboard.

This allows an image of the current plot area to be pasted into a document or spreadsheet.
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Zoom In/Out
The Zoom In/Out button allows the user to enlarge areas of the chart.

To zoom in, click the button and then click and drag an area on the chart. This will display the
selected area stretched to fill the full range of the chart screen. Alternatively, click the Zoom In/Out
button and then simply left click on the chart area to zoom in. The minimum number of samples
that can be displayed is 10.
To zoom out, click the Zoom In/Out button and the right click on the chart area.

© 2006 USB-Instruments

25

3.3.6

EasyLogger for DS1M12 Help

Zoom Full
The Zoom Full button scales the x-axis to display the number of data points specified in Max
Samples of the Settings section of the Edit menu.

To change the number of data points stored in memory, see Settings from the Edit menu. The
default value is 10000 samples.
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Cursors
Three cursors are available. These are:
Data Cursor

Missed Sample Cursor

Marker Cursor

They have different colours and names to allow them to be distinguished easily.

By right clicking on the cursor icons on the main toolbar, the user may select whether the cursor is
associated with channel A or channel B by selecting the desired channel from the pop-up menu
(shown below).
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Each of the cursors can be moved by dragging the name label horizontally. Vertical dragging will
have no effect as the cursors automatically track the data line.
The x and y coordinates of each active cursor are displayed in the Cursor Panel at the bottom left
of the main window.

The delta column can be made to display the differences in x and y between two of the cursors.
Right click on the word "Delta" and the following menu will appear:

Selecting "Data - Missed", "Data - Marker" or "Missed - Marker" will display the differences
between those cursors. The delta values can be turned off by selecting "Off". The following
example shows the differences in x and y values between the Data and Missed cursors for the
trace given above.
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TestMode Waveform
Clicking on the TestMode Waveform button activates the EasyLogger test mode. This produces a
saw-tooth waveform without any input to the device.

Any input to the device will be ignored while test mode is active. The frequency of the waveform is
30.518Hz.
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Signal Generator
Clicking the Signal Generator button shows the Signal Generator Window.

This window allows the output from the signal generator to be configured. This is disabled while
the logger is running.
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3.3.10 Memo Window
Clicking the Memo Window button shows the Memo window.

This allows markers and information to be added to the chart.
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3.3.11 Info Window
Clicking the Info Window button shows the Info Window.

The Info Window displays information about the current chart.
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3.3.12 X-Control Window
Clicking the X-Control Window button shows the X-Control Window.

This allows the range and scale of the x axis to be changed.
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3.3.13 Y-Control Window
Clicking the Y-Control Window button shows the Y-Control Window.

This allows the range and scale of the y axis to be changed.
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3.4.1

Signal Generator Window
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Selecting the SignalGen option from the run menu or clicking the Signal Generator button from the
main toolbar displays the configuration window for the signal generator output (shown below).

This allows the operator to select a pre-defined waveform from
·
·
·
·
·
·

DC output
Sawtooth
Square
Sine
Triangle
Pulse

Each of these waveforms may be adjusted in amplitude, ground offset and frequency. In addition,
there is an option to load a custom waveform from a .CSV file. This file should have one column of
millivolt values, one for each sample. The maximum number of samples permitted is 1024. If the
file contains more than 1024 data points, only the first 1024 points will be used to generate the
pattern.
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Memo Window
The Memo Window is shown below.

This can be used to manually comment the data on the chart.
To do this, click "Marker" and click on the chart where the marker is desired. This will add the
marker to the chart. Next, type a memo in the memo text box and then click "Add". This will add
the text to the memo list.
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This process may be repeated to add multiple markers to the chart. The markers appear as green
circles by default.

Double-clicking on a memo in the memo window will jump to the corresponding marker on the
chart.

© 2006 USB-Instruments

37

EasyLogger for DS1M12 Help
To remove markers, simply select the marker from the list in the Memo Window and click
"Remove".
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Info Window
The Info Window contains general data for the current chart, such as start date, start time and
sample interval for each channel. An example is given below.

In the event that there are missed samples in the trace, the total number of missed samples is
indicated next to "Missed:". The arrows may be used to seek the missed data points. When a
missed data point is found using the arrow buttons, the missed cursor is applied at the same point
to highlight the location.
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X-Control Window
The X-Control window is shown below and provides manual control over the X-axis.
The scale unit may be changed between time and number of samples by clicking the "Time" and
"Samples" buttons respectively.

Values for the maximum and minimum scales values may then be entered in the text boxes and
the display is updated when the "Apply" button is clicked.
The scale units may also be switched between number of samples and time by clicking on the axis
label on the chart.

© 2006 USB-Instruments

Using EasyLogger for DS1M12

3.4.5

40

Y-Control Window
The Y-Control window (shown below) allows the chart Y-scale to be customised.

The window is divided into three sections. Each is described below:
Y-Scale
This allows the range of the Y scale to be manually adjusted. Simply enter the desired maximum
and minimum values in the text boxes and click "Apply" to change the scale.
Y-Scale Parameter
This allows the units of the Y-axis to be changed. Volts (V) and milli-Volts (mV) are provided by
default, but custom units may be created by clicking the "New" button and filling in the form below.
Click "OK" to add the new units to the list of available units.

Custom units can be removed from the list by selecting them from the combo box and then clicking
"Remove".
Saturation Voltage (V)
This panel provides control over the ADC saturation Voltage limit and coupling for channel A and
channel B. In addition, activating the "X10" button as this will re-scale for a X10 probe as indicated
below. Channel A or channel B can be configured by selecting the appropriate tab from the right
hand edge of the Saturation Voltage panel.
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If the Voltage saturation level is exceeded, the data will be clipped to the saturation value and
displayed in a different colour. The colour for clipped data can be customised through the
View menu. If data is clipped, a memo is added in any exported file to indicate that clipping has
occurred.
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File Menu
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The File menu (shown below) provides alternative access to functions available on the main
toolbar.

Load
This provides the same functionality as the Open Chart button from the toolbar. An open dialog
box is shown for the user to select a .dlog or .rdl file to load to the load chart.
Save
This provides the same functionality as the Save Chart button from the main toolbar. A save dialog
box is shown that allows the user to save the current data as a bitmap file (*.bmp), a comma
separated values file (*.csv), a text file (*.txt) or a data logger format file (*.dlog). Data may be
saved from either the data chart or the load chart.
Close
The close option clears the selected chart. If the Load chart is displayed, the chart is cleared and
is no longer selectable from the Window menu. If the Data chart is displayed, the chart is cleared
in the same way as Clear Screen from the Edit menu.
Print Chart Area
This provides the same functionality as the Print Chart Area button from the main toolbar.
Print Data logger
This option sends the whole data logger panel image to the printer rather than just the plot area.
This can provide a useful record of the data logger settings used to acquire the trace.
Restore Backup
Selecting Restore Backup will load data from the previous run if "Backup Data on Exit" is enabled
in the Settings section of the Edit menu. If "Backup data on Exit" is disabled, the option will be
greyed out.
Exit
The Exit option allows the user to quit the application and has the same function as the Windows
Close button .
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Run Menu
The Run menu (shown below) provides access to the following functions:

Start
This provides the same function as clicking the Start Button. Selecting "Start" begins data logging
with the specified sample rate and Voltage saturation limit.
Stop
This option provides the same functionality as the Stop Button. Selecting "Stop" will terminate data
logging.
Channel A
Selecting Channel A will enable or disable channel A in the same way as clicking the
Channel Enable button for channel A. When the channel is enabled, a tick is visible next to the
channel name.
Channel B
Selecting Channel B will enable or disable channel B in the same way as clicking the
Channel Enable button for channel B. When the channel is enabled, a tick is visible next to the
channel name.
TestMode
Selecting TestMode activates the EasyLogger test mode in the same way as the
TestMode Waveform button from the main toolbar. This creates a saw-tooth waveform with a
frequency of 30.518Hz.
SigGen
Selecting SigGen brings up the Signal Generator Window for configuring the signal generator
output. This has the same functionality as the Signal Generator button on the main toolbar.
Clear Screen
Selecting Clear Screen removes all data from the data chart. This option is disabled if the load
chart is selected.
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Edit Menu
The Edit menu (shown below) allows access to the following functions:

Copy Chart to Clipboard
This option provides the same functionality as the Copy Chart to Clipboard button on the main
toolbar. This copies an image of the chart area to the Windows clipboard for pasting into
documents or spreadsheets.

X Scale
Selecting X Scale displays the following sub-menu.

This allows the units of the X-axis to be changed between time and sample number. The units of
the X-axis can also be changed through the X-Control Window or by clicking on the axis label.
Y Scale
Selecting Y Scale displays the following sub-menu.

This allows the units of the Y-axis to be changed between the default units of V (Volts) and mV
(millivolts). The units of the Y-axis can also be changed through the Y-Control Window. To display
custom units on the Y-axis, use the Y-Control Window. The units of the Y-axis may also be
changed by clicking on the axis label.
Settings
Through the settings option, a window appears which allows access to four tabs: Samples, Chart
Labels, Alerts and Data Format.

·

Samples

The samples tab is shown below. The "Max number of Samples" value is the maximum number of
samples that may be displayed on the X-axis at Zoom Full. All data is writen to a file and only the
currently visible data is in memory. The figure quoted for "Approx. Memory Usage" is for when the
maximum number of samples is being displayed.
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·

Chart Labels

The chart labels tab is shown below. This allows customisation of which text labels are visible on
the chart at the start and stop markers. Please note that regardless of which options are checked
here, all exported data files will contain all of this information. Checking the "Display on Chart"
option for memos shows memos on the chart area.

·

Alerts

The alerts tab is shown below. This can be used to configure up to four alerts to flag when the
logged data reaches a critical value. Alert types are pop-up windows, e-mails or both. A valid email address and network connection are required for the e-mail alerts. Alerts can be configured
for when values are greater than or less than some value on either channel A or channel B.
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Data Format

The Data Format tab is shown below. This controls whether the data is stored in it's raw state or is
formatted. Raw data storage allows faster logging times, but the display is not updated while
logging is in progress. When logging is terminated, the data is processed and the display updated.
Raw data files have a .RDL extension while formatted data files have a .DLOG extension.

The following screen shows an example of the message displayed while data is being logged in .rdl
format.
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View Menu
The View menu (shown below) allows the user to change the appearance of the EasyLogger.

Customise Screen Colours
Selecting Customise Screen Colours shows the following sub-menu:

Selecting any of the options available on this sub-menu allows the user to select a new colour for
the selected item. Selecting "Restore Defaults" resets all colour settings to the original colours.
ChA Trace
This allows trace A to be made visible or invisible. This option does not affect if data is logged or
not. To enable/disable logging on channel A, use the Channel Enable Button on the front panel or
toggle Channel A from the Run menu.
ChB Trace
This allows trace B to be made visible or invisible. This option does not affect if data is logged or
not. To enable/disable logging on channel B, use the Channel Enable Button on the front panel or
toggle Channel B from the Run menu.
Text Labels
Selecting Text Labels will check or un-check the text labels option. This will toggle whether start
and stop marker text labels are shown on the chart or not.
Track Data Logger
Selecting Track Data Logger will check or un-check the tracking option. This will toggle whether
the chart updates constantly to show the newly acquired data or allow the display to remain static.
The slide bar is disabled if tracking is enabled and the slide bar is enabled if tracking is disabled.
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Grid
Selecting Grid will check or un-check the grid option. This will toggle whether the grid is shown on
the chart or not.
Zoom
Selecting Zoom from the menu displays the Zoom sub-menu (shown below).

These functions provide the same functionality as the Zoom In/Out and Zoom Full buttons and can
be used to enlarge or shrink an area of the display. Keyboard shortcuts are also indicated in the
menu.
Windows
Selecting Windows from the menu displays the Windows sub-menu (shown below).

This provides the same control over which windows are visible as the Memo Window,
Info Window, X-Control Window and Y-Control Window buttons on the main toolbar. In addition,
there are options to display all windows or to close all windows.
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Window Menu
The Window menu allows the user to select whether the data chart or the load chart data is
displayed.
By default, the load window is not selectable as there is no file loaded.

If a .dlog or .rdl file is loaded using the either the Open Chart button or the Load option from the
File menu, the load chart becomes selectable from the window menu. The following example
shows the window menu after a .dlog file called Test Data.dlog has been loaded.

The window currently displayed is indicated by a l.
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Help Menu
The following options are available through the Help menu (shown below).

HTML Help
Selecting HTML Help from the menu will launch this help file.
About ...
The About ... option displays version information and release dates.
USB-Instruments Web Site
This will connect to the Internet and take the user directly to the USB Instruments web site where
information can be found on products and updates.
On-Line User Manual
This option will take the user to the EasyLogger manual section of the USB Instruments web site.
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Quitting EasyLogger
EasyLogger can be exited by either accessing the Exit option of the File menu or clicking the
Windows Close button
in the top right-hand corner of the window.
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Appendix

4.1

Error Messages

4.1.1

RBF File Not Found
This error occurs when EasyLogger cannot find the file to program the DS1M12 hardware.

To resolve this problem click "OK", quit the EasyLogger application and check that the file
DDL1M12.rbf exists in the same directory as the EasyLogger application program. If the file is
there, try to re-launch the EasyLogger application ensuring that the instrument is connected to the
PC. If the file is not there, it may be retrieved by browsing the installation CD and copying it to the
same location as the EasyLogger application.
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Failed to Configure DS1M12
This error occurs when the EasyLogger application cannot detect any instruments connected to the
PC when it is launched.

Ensure that the instrument is connected to the PC and that the correct drivers are installed, then
re-launch the EasyLogger application.
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DS1M12A B Not Found ...
This error can occur when trying to run the EasyLogger application with no DS1M12 hardware
connected to the PC.

To resolve this, connect a DS1M12 to the PC and run the application again. If this has no effect,
check that the drivers are installed correctly.
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FT_Write - General IO Error ...
This error may occur if the DS1M12 is unexpectedly disconnected from the PC while the program
is running.

A message box with this error may appear several times but will clear and run as normal after
clicking "OK" on each message box that appears.
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4.1.5
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FT_GetQueueStatus - General IO Error ...
This error may occur if the DS1M12 is unexpectedly disconnected from the PC while the program
is running.

A message box with this error may appear several times but will clear and run as normal after
clicking "OK" on each message box that appears.
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Uninstalling EasyLogger
From the Start -> Programs -> USB Instruments DS1M12 menu on the Windows Toolbar, select
the Uninstall DS1M12 Option and click on it.

This will start the uninstaller program. The following confirmation screen will appear.

If you are sure you want to uninstall the EasyLogger Program, click on "Next". If not, click on
"Cancel" to abort the Uninstall process.
Clicking on "Next" starts the uninstall sequence. When the EasyLogger Software is run for the first
time, it automatically creates an INI file (easyscope.ini) to store program settings and two BMP files
(DSBright.bmp and DSNormal.bmp) containing the images of the Normal and Bright screen
themes. It is safe to delete these if asked by the uninstaller. In the course of using EasyLogger
the user may have saved some screen images and should decide if they want to keep these or not.
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Click on "Finish" to complete the uninstallation.
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*.csv 20, 21, 35
*.dlog 20, 21
*.txt 20, 21, 35

-..bmp 20, 21, 23
.csv 20, 21, 35
.dlog 20, 21
.txt 20, 21, 35

-Aabout 51
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alert 44
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area 19

-Bbar 18
begin 14, 43
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-Ccapture 14
CD 5
chart 19, 22, 30, 31, 35, 38, 50
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clipping 33, 40
close 42
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controls 13
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cursor 26
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custom 30, 35, 40
customise 48
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-Ddata 18, 20, 21, 26, 38
data log format 20, 21
Data1 50
date 38
delta 26
difference 26
display 19, 20, 21, 50
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driver 10
drivers 10
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-Ffailed 54
failed to program penscope hardware
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file 42, 53
file menu 42
file not found 53
format 20, 21
found 53, 55
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frequency 16
FT_GetQueueStatus
FT_Write 56
full 25, 48
functions 13
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-GGeneral IO Error
go 43
grid 48

56, 57

-Hhalt 15
hardware 54
help 51
HTML 51
HTML help 51

-Iimage 22, 42, 44
import 20, 42
in 24, 48
info 31, 38, 48
info window 48
install 5, 10, 58
installation 5, 10, 58
installing 5, 10, 58
instrument 13, 14, 15, 16, 18, 51, 52, 53, 54, 55,
56, 57, 58
introduction 3
IO 56, 57

-Llabel 30, 35
labels 44, 48
load 20, 42, 50
log 14, 15, 16, 20, 21
logging frequency 16
logging rate 16

-Mmarker 26, 30, 35
markers 44
maximum 38
memo 30, 35, 48
memo window 48
memory 44
menu 42, 43, 48, 50
message 44
milliVolts 40, 44
milli-Volts 40, 44
minimum 38
missed 16, 26, 38
mode 28, 43
mV 40, 44

-Oon-line 51
open 20, 42
operating system
OS 3
out 24, 48
overview 13

3

-Ppanel 26
paste 23
penscope 51, 52, 53, 54, 55, 56, 57, 58
picture 22, 23, 42, 44
pop-up 44
print 22, 42
program 54
ps40m10b 55
ps40m10b not found 55
PSDLOG.rbf 53

-Qquit

42, 52
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-Rrange 19, 24, 25, 32, 33, 39, 40
rate 16
remove 58
run 14, 43
run menu 43

-Ssample 16
sample rate 16, 38
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sampling rate 16
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save 21, 35, 42
scale 24, 25, 32, 33, 39, 40, 44
scale 19
screen 43
scroll 18
separated 20, 21, 35
settings 44
slide 18
slide bar 18
software 5, 13, 51, 52, 53, 54, 55, 56, 57, 58
specification 4
start 14, 38, 43
stop 15, 43

-Tterminate 43
test 28, 43
testmode 28, 43
text 20, 21, 35, 48
text labels 48
time 38, 39, 44
toolbar 20, 21, 26, 28
track 48
track data logger 48
tracking 48
txt 20, 21, 35

-Uuninstall 58
un-install 58
uninstallation 58
un-installation 58
uninstalling 58
un-installing 58
units 32, 33, 39, 40
USB 3, 10
usb instruments 51
user 51
user manual 51

-VV 40, 44
values 20, 21, 35
view 48
view menu 48
Volts 40, 44

-Wwaveform 28
web 51
web site 51
welcome 3
window 30, 31, 32, 33, 35, 38, 39, 40, 44, 50
window menu 50
windows 48
wizard 10

-XX 32, 39, 44, 48
X-Control 32, 39, 48
X-Control Window 48
X-scale 44

-YY 33, 40, 44, 48
Y-Control 33, 40, 48
Y-Control Window 48
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-Zzoom 24, 25, 48
zoom full 48
zoom in 48
zoom out 48
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